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Hình. Khởi động MS-Word từ nút Start 
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Làm quen với MS-Word 

Chương trình soạn thảo văn bản Microsoft Word là một phần mềm thuộc bộ 

chương trình Microsoft Office nổi tiếng của hãng Microsoft. Đây là một bộ soan 

thảo trực quan, hay còn gọi là WYSIWYG (What You See Is What You Get), có 

giao diện đẹp và dễ sử dụng. MS Word có nhiều tính năng mạnh mẽ, được coi 

như một công cụ chuyên nghiệp trong công nghệ chế bản. 
 

 

Bước đầu làm việc với chương trình 
icrosoft Word là một chương trình ứng dụng xử lý văn bản trên nền hệ 
điều hành Windows. 

 

 

 

 

Khởi động MS-Word 

Có hai cách khởi động chương trình: 

Cách 1: Nhấn đúp chuột vào nút bấm nhanh của chương trình trên Desktop. 

 

 

 

 

Hình. Nút bấm nhanh 

Cách 2: Nhấn chuột vào nút Start của Windows, sau đó chọn Programs. Tiếp theo bấm 

chọn mục Microsoft Office  để chọn Microsoft Office Word. 
 

 

Chương 

1 
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X 

MMàànn  hhììnnhh  llààmm  vviiệệcc 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Hình. Cửa sổ làm việc của chương trình 
 

 

Màn hình chính gồm các phần cơ bản như sau: 

 Thanh tiêu đề 

 Thanh thực đơn lệnh (Menu bar): Chứa các nhóm làm việc với cửa sổ, 

thư mục và tệp tin gồm: File, Home, Insert,... 

 Các thanh công cụ (Toolbars): Gồm các nút biểu tượng cho các lệnh giúp 

cho thác tác lệnh được nhanh chóng và chính xác. 

 Vùng soạn thảo văn bản (Text Area): nơi soạn thảo và chỉnh sửa văn 

bản. 

 Con trỏ văn bản (Cursor) : Có dạng một thanh đứng nhấp nháy xác định 

vị trí nhập văn bản. Ngoài ra chúng ta vẫn thấy con trỏ chuột với hình 

dáng mũi tên đã quen thuộc khi sử dụng hệ điều hành. 

 Thanh trạng thái : cho biết con trỏ văn bản đang ở trang nào, dòng nào, 

cột nào,... 

 Ba nút thao tác với cửa sổ gồm: nút thu nhỏ cửa sổ, phóng to cửa sổ, 

đóng cửa sổ 
 

 

Thoát khỏi MS-Word 

Sau khi làm việc xong, muốn thoát khỏi MS-Word và quay về màn hình làm việc của 

Windows: 

Cách thứ 1: Nhấn chuột vào thực đơn File -> Close. 

Cách thứ 2: Nhấn nút tại góc trên bên phải của cửa sổ chương trình MS-Word. 

Thanh tiêu đề 

 
Thanh thực đơn 

 

Thanh cuộn dọc 

 

Thanh công cụ 
Thanh thước 

 

Vùng soạn thảo 

 

Thanh trạng thái 
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Mở /sao lưu/đóng tệp văn bản 

MMởở  ccửửaa  ssổổ  mmớớii  đđểể  ssooạạnn  vvăănn  bbảảnn 

 Khi khởi động, MS-Word luôn tự động tạo một cửa sổ mới có tên ngầm 

định là Document1. Sau khi nhập văn bản và lưu thành tệp tin thì tên cửa 

sổ được thay đổi theo tên người dùng tự đặt. 

 Muốn mở thêm một cửa sổ mới để soạn văn bản cần thao tác như sau: 

Vào thực đơn File --> chọn New --> chọn trong hộp thoại định dạng gốc của văn 

bản, để tạo mới văn bản trắng chọn Blank Document. Tệp văn bản mới sẽ có tên 

ngầm định là Document1, Document2, ... 

 
 

Hình. Tạo mới một tài liệu MS-Word 
 

 

GGhhii  llưưuu 

Nhấn vào nút Save trên thanh công cụ hoặc sử dụng lệnh Save… trong thực đơn lệnh 

File. Lần đầu tiên lưu tệp tài liệu chúng ta sẽ phải thực hiện: 

 Đặt tên cho tài liệu: Gõ tên tài liệu (nên gõ không dấu và không có 

khoảng trống) vào hộp thoại File name. 

 Chọn thư mục (nơi đặt tệp văn bản) trong hộp thoại Save in. Có thể nhấn 

vào các biểu tượng (History, My Documents, Desktop, Favorite,..) trên 

thanh công cụ bên trái hộp thoại Save in để truy cập nhanh đến các thư 

mục lớn trong máy tính. 
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Hình. Ghi lưu tài liệu mới 

Trong hình minh họa, thao tác các mục sau: 

(1) chọn nhanh các thư mục hay dùng như: My Documents, Desktop 

(2) tạo thư mục mới cho phép tạo thư mục mới mà không cần trở về màn hình chính 

(3) sử dụng các nút tiện ích: di chuyển tiến/lùi các thư mục, xem văn bản theo dạng rút 

gọn hay đầy đủ, sắp xếp tệp và thư mục theo tên, phần mở rộng, ngày cập nhật,... 

(4) gõ tên cho tệp văn bản trong ô File name 

(5) có thể chọn kiểu tệp sao lưu khác như .htm, .dot, .rtf, .txt  bằng cách chọn trong ô 

Save as Type. 

 
 

 

Bấm vào đây để 

chọn các ổ đĩa hay 

các thư mục khác 

 

Chọn nhanh các 

thư mục hay dùng 

tại đây 

Tạo mới 

thư mục 

 

Nút tiện 

ích 

 

Nút tiện 

ích 

 

Nút tiện 

ích 
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ĐĐóónngg  ttààii  lliiệệuu 

Chọn lệnh Close trong thực đơn lệnh File để đóng cửa sổ soạn thảo văn bản. 

Khi đóng cửa sổ văn bản, có hai khả năng như sau : 

 Nếu tài liệu soạn thảo đã được đặt tên, MS-Word sẽ hiển thị hộp thoại 

khi xác định nội dung tệp văn bản đã có chỉnh sửa. Nhấn nút Yes - để 

đồng ý ghi nội dung mới thay cho nội dung cũ; nhấn nút No - để giữ 

nguyên bản cũ, nhưng gì mới chỉnh sửa xem như bỏ qua; nhấn nút 

Cancel để đóng hộp thoại, trở về lại cửa sổ sọan thảo: 

 
 

 Nếu tài liệu chưa được đặt tên - MS-Word mở hộp thoại Save in như đã 

thao tác trong nội dung sao lưu. 
 

MMởở  ttệệpp  vvăănn  bbảảnn  ccóó  ssẵẵnn  ttrrêênn  đđĩĩaa 

Nhấn chọn thực đơn File->Open -> Browse để mở hộp thoại Open như hình minh họa 

dưới đây: 

 
 

Hình. Mở một tài liệu đã có sẵn trên đĩa. 
 

 

* Chọn một tệp văn bản đã có trong thư mục. Có thể sử dụng các nút tiện ích di chuyển 

thư mục để tìm đến tệp tin muốn mở. Lưu ý các tệp văn bản của Word từ 2007 mặc 

định có phần mở rộng là .docx. 

Có thể chọn một 

hoặc nhiều tệp văn 

bản 

 

Nút tiện ích giúp 

di chuyển giữa 

các thư mục 
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* Để mở một tệp văn bản, nhấn đúp chuột vào tên tệp hoặc nhấn đơn (tệp sẽ được đánh 

dấu chọn – bôi đen) rồi nhấn nút Open. 

* Để mở nhiều tài liệu cùng lúc, đánh dấu chọn các tệp cần mở (nhấn phím Shift để 

chọn các tệp kề nhau hoặc phím Ctrl để bôi đen các tệp không kề nhau) rồi nhấn nút 

Open. 

Thao tác nhanh: Có thể mở nhanh hộp thoại Open để mở một tài liệu có sẵn bằng 

cách nhấn tổ hợp phím tắt Ctrl+O. 

 

GGiiớớii  tthhiiệệuu  tthhaannhh  ccôônngg  ccụụ  RRiibbbboonn 

MS-Word hỗ trợ các thanh công cụ giúp cho người sử dụng thao tác được nhanh 

và chính xác hơn. 

CChhee  ddấấuu//  hhiiểểnn  tthhịị  tthhaannhh  ccôônngg  ccụụ:: 

 Nhấn Ctrl + F1 hoặc 

 Nhấn chọn (như hình) để hiển thị/che dấu thanh công cụ 

Ribbon. 

 

Hình. Thao tác để che dấu hoặc hiển thị các thanh công cụ 
 

TTiiệệnn  íícchh  pphhóónngg  ttoo,,  tthhuu  nnhhỏỏ  ttrraanngg  ssooạạnn  tthhảảoo 

Theo mặc định, kích thước hiển thị một trang soạn thảo trên màn hình là 100%. Người 

dùng có thể phóng to trang tài liệu lên tối đa 500% hoặc thu nhỏ xuống còn 10% kích 

thước thực với công cụ Zoom. Việc thay đổi kích thước không làm thay đổi khuôn dạng 

thực của văn bản khi in ra. Vào thực đơn View --> Zoom 



W-10  

 
 

Hình. Công cụ Zoom 
 

Chuẩn bị trước khi soạn văn bản 

Trước khi soạn thảo công việc định hướng cho khung văn bản soạn thảo là việc rất quan 

trọng. Chúng ta phải xác định văn bản được soạn ưu tiên theo chiều ngang hay chiều 

dọc, phông chữ khi nhập thô (tức là nhập mà chưa cần chỉnh sửa) là bao nhiêu,... Công 

việc thiết lập này chỉ đòi hỏi  làm một lần. 

TThhiiếếtt  llậậpp  PPaaggee  SSeettuupp 

+ Nhấn chọn thực đơn lệnh Layout -> Page Setup làm xuất hiện hộp thoại Page Setup 
 

* Thẻ Margins trên hộp thoại Page Setup 

Cho phép đặt lề trái, phải, trên dưới cho văn bản. Khi điều chỉnh các tuỳ chọn nên chú ý 

đến hình minh họa (Preview). Các tham số trên hình là ví dụ thực tế để tham khảo.  

Thay đổi hướng của nội dung văn. Việc này rất quan trọng cho việc thể hiện các loại văn 

bản khác nhau. Ví dụ văn bản là thông báo của thủ trưởng đến các đơn vị thì phải chọn 

khổ giấy theo chiều dọc (Portrait), còn bảng minh họa sơ đồ tổ chức đơn vị cần chọn 

theo chiều ngang (Landscape) để trình bày được đầy đủ trong một trang. 

Sau khi chỉnh sửa, nhấn nút Set As Default để ghi nhận trạng thái mới. Trạng thái 

mới được áp dụng ngay cho văn bản đang soạn. (Không cần phải làm lại lần thứ hai nếu 

không có ý định thay đổi). 
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Nút để ghi nhận 

trạng thái mới 
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* Thẻ Paper Size: Cho phép chọn khổ giấy in thông thường sử dụng khổ giấy A4.  

 

TThhiiếếtt  llậậpp  pphhôônngg  cchhữữ 

+ Nhấn chọn thực đơn lệnh Home -> Font làm xuất hiện hộp thoại Font. 
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* Theo hình vẽ, phông chữ Times New Roman là phông chữ được sử dụng ngầm định 

cho bất cứ trang văn bản mới. Người dùng có thể thao tác chọn phông chữ khác, cỡ chữ 

khác. Ví dụ phông chữ mới là Arial, cỡ chữ 13. 

* Sau khi chọn phải nhấn vào nút Set As Default để ghi nhận lại sự thay đổi. 
 

Soạn thảo văn bản 

QQuuii  ttắắcc  ccơơ  bbảảnn  kkhhii  nnhhậậpp  vvăănn  bbảảnn 

 Nhập nhanh văn bản. Khi được nhận một văn bản, người sử dụng thực 

hiện nhập nhanh văn bản. Văn bản được nhập nhanh không đòi hỏi phải 

đúng theo văn bản sẵn có, không chỉnh khuôn dạng ngay khi nhập. Ví dụ 

sau khi nhập 1 dòng văn bản không cần thiết in đậm ngay các dòng chữ. 

 Chữ cái đầu câu phải được viết hoa. Khi nhập nhanh văn bản phải chú 

ý đến việc gõ chữ hoa cho các chữ cái đầu tiên vì sau khi nhập xong 

chúng ta không thể chỉnh sửa lại từng chữ cái một cách nhanh chóng 

được. Trong MS-Word không thực hiện chức năng tự động chuyển các 

chữ cái tiếng Việt đầu câu thành chữ hoa một cách chính xác. 

 Dấu phẩy và dấu chấm phải đi liền với các chữ ngay trước nó. 
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CCáácc  pphhíímm  đđiiềềuu  kkhhiiểểnn  ccoonn  ttrrỏỏ  vvăănn 

bbảảnn 

Bốn phím mũi tên: Lên trên, Xuống 

dưới, Sang trái, Sang phải sử dụng để 

di chuyển con trỏ soạn thảo. 

Trong khi soan thảo có thể sử dụng 

thanh cuộn  ngang/dọc để xem phần 

bị che khuất. 

 
 

M ộ t   s ố   p h í m   d ị c h   c h u y ể n   v ị   t r í 
 

 

 Page Up: Dịch con trỏ lên một trang 

màn hình. 

 Page Down: Dịch con trỏ xuống một 

trang màn hình. 

 Home: Đưa con trỏ về đầu dòng hiện tại 

 End: Đưa con trỏ về cuối dòng hiện tại 

 Ctrl+Home: Đưa con trỏ về đầu dòng 

đầu tiên của văn bản 

 Ctrl+End: Đưa con trỏ về vị trí cuối cùng của 
 

CChhếế  đđộộ  cchhèènn  vvàà  gghhii  đđèè  kkíí  ttựự 

Chế độ chèn (Insert) và chế độ ghi đè (OverWrite). 

 ở chế độ chèn, kí tự 

gõ vào được thêm 

ngay sau vị trí con 

trỏ. Các kí tự ở tiếp 

sau (nếu có) sẽ dịch 

sang phải. 

 ở chế độ ghi đè, kí 

tự gõ vào sẽ đè lên 

thay thế cho kí tự 

ngay bên phải con 

trỏ. Các kí tự khác 

không có sự dịch 

chuyển vị trí. 

  M ộ  t    s ố     p h í m    c h ứ  c    n ă  n g  c ơ     b ả  n   

 Caps Lock: Bật/ tắt chế độ viết chữ hoa. 

 Shift+<Phím kí tự>: Giữ Shift trong khi ấn 

một phím kí tự sẽ được chữ hoa (trong trạng 

thái Caps Lock tắt) 

 Delete: Xoá ký tự bên phải con trỏ soạn thảo 

 Back Space: Xoá ký tự bên trái con trỏ 

soạn thảo 

 Space Bar: Tạo dấu trống 

 Insert : chuyển đổi chế độ chèn/ghi đè 

Phím  Insert cho phép chuyển đổi giữa hai chế độ. 
 

 

TThhựựcc  hhàànnhh  nnhhậậpp  vvăănn  bbảảnn  ssaauu 
 

 
 

 

Lựa chọn văn bản 

Phương pháp chung lựa chọn đối tượng văn bản: 

 Dùng chuột: đặt con trỏ chuột tại điểm đầu đối tượng cần chọn, nhấn và 

kéo di chuột đến cuối đối tượng. 

 Dùng bàn phím: Đưa con trỏ văn bản đến điểm đầu đối tượng cần chọn, 

giữ phím Shift và ấn phím mũi tên (trái, phải, lên, xuống) để mở rộng 

vùng chọn. 

Văn bản được chọn thường được hiển thị trên nền có màu tương phản với màu văn bản 

gốc vì thế thao tác chọn văn bản cũng được gọi nôm na là “bôi đen văn bản”. 

Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc 

thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Hoa sữa nở vào độ cuối thu đầu đông, những cụm hoa nhỏ xíu chen chúc từng đám mầu 

trắng phớt. 
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TThhựựcc  hhàànnhh  vvớớii  kkíí  ttựự,,  ttừừ,,  ccââuu,,  ddòònngg  vvăănn  bbảảnn,,  đđooạạnn  vvăănn  bbảảnn 

Kí tự: kí tự có thể là chữ cái hoặc chữ số và những kí tự khác có thể nhập vào từ bàn 

phím. 

Một từ: một dãy kí tự liên tiếp không có khoảng trống được xem là một từ. 

Thao tác nhanh: 

 Nhấn đúp chuột tại vị trí bên trái một kí tự bất kỳ của từ. 

 

Một câu: trong một dãy các từ, dấu chấm xác định kết thúc một câu. 

Thao tác nhanh: 

 Giữ phím Ctrl và nhấn chuột tại vị trí bên trái một kí tự bất kỳ của câu để 

chọn được cả câu. 

 Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc  

 thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Hoa sữa nở vào độ cuối thu đầu đông, những cụm hoa nhỏ xíu chen chúc từng đám mầu 

trắng phớt. 

Một dòng: gồm các từ cùng nằm trên dòng. 

Thao tác nhanh: 

 Nhấn chuột ở đầu dòng để chọn một dòng. Kết hợp với phím Shift để 

chọn nhiều dòng. 

 

Đoạn văn bản: gồm các dòng văn bản được kết thúc bởi một lần bấm phím Enter. 

Nếu đang soạn văn bản mà sử dụng tổ hợp phím Shift-Enter vẫn có thể đặt con trỏ soạn 

thảo về đầu dòng cuối nhưng không làm kết thúc đoạn văn bản. 

Thao tác nhanh: 

 Nhắp chuột trái ba lần tại vị trí bất kỳ của đọan để chọn được cả đoạn 

văn bản. 

 Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc 

thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

 

 chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt.  
Hoa sữa nở vào độ cuối thu đầu đông, những cụm hoa nhỏ xíu chen chúc từng đám mầu 

trắng phớt. 

Một khối văn bản: xuất phát với một từ bất kỳ trong dòng văn bản  và kết thúc tại một 

từ khác bất kỳ trên các dòng văn bản. 

Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc 

thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Hoa sữa nở vào độ cuối thu đầu đông, những cụm hoa nhỏ xíu chen chúc từng đám mầu 

trắng phớt. 

Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc 

thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Hoa sữa nở vào độ cuối thu đầu đông, những cụm hoa nhỏ xíu chen chúc từng đám mầu 

trắng phớt. 
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Undo Ctrl-Y Ctrl-Z Redo 

 

Hoa sữa không biết được du nhập vào Hà Nội từ bao giờ , cây cao, dáng đẹp, thân mốc  

 thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, 

chỉ lác đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Thao tác chọn với bàn phím 

 Đặt con trỏ văn bản tại vị trí bất kỳ, giữ phím Shift, bấm phím điều khiển 

sang trái/ phải, lên/xuống dòng để chọn văn bản. 

 Đặt con trỏ văn bản ở đầu một dòng, giữ phím Shift, bấm phím End để 

chọn cả dòng. 

 Đặt con trỏ văn bản ở cuối dòng, giữ phím Shift, bấm phím Home để 

chọn cả dòng. 

 Nhấn tổ hợp phím  Ctrl+A để chọn toàn bộ văn bản. 
 

Hủy lựa chọn đối tượng văn bản 

 Có thể tăng giảm vùng văn bản được chọn bằng cách sử dụng con chuột 

hay bàn phím trong khi thao tác chọn. 

 Để hủy lựa chọn toàn bộ văn bản đã chọn, chỉ cần nhắp phím chuột tại vị 

trí bất kỳ hoặc bấm một phím điều khiển. 

Lưu ý: Sau khi đã đánh dấu văn bản thì khả năng làm mất văn bản rất cao.Ví dụ thực 

hiện chọn toàn bộ văn bản, sau đó nhấn phím SpaceBar thì toàn bộ văn bản biến mất 

hoặc. Để hồi phục lại văn bản hãy sử dụng chức năng Undo/Redo. 
 

Sử dụng chức năng Undo/Redo 

Chức năng Undo rất hữu ích trong trường hợp người soạn thảo có sai sót khi chỉnh sửa, 

xoá bỏ văn bản. MS-Word cho phép thao tác Undo nhiều lần để trả lại một trạng thái cũ 

đã qua nhiều bước thực hiện. 

Chú ý: Người dùng không thể thao tác Undo nếu đã làm thao tác SAVE. Trước khi 

SAVE thì mọi dữ liệu của văn bản đang được lưu tạm trên bộ nhớ chính của máy tính, 

nên MS-Word cho phép phục hồi lại trạng thái cũ. Khi thực hiện SAVE các dữ liệu tạm 

thời bị xoá bỏ và nội dung văn bản được ghi lên bộ nhớ ngoài (đĩa mềm hay đĩa cứng) 

nên văn bản không còn khả năng phục hồi bằng Undo. 

Chức năng Redo, cho phép trả lại trạng thái đã trước khi thao tác Undo. 

Cách 1: trên thanh lệnh, vào mục Home --> chọn Undo hoặc Redo. 

Cách 2: bấm chọn Undo  Redo ngay trên thanh công cụ. 

Cách 3: Sử dụng tổ hợp phím tắt thay cho và cho . 
 

Sao chép (copy), cắt (cut) và dán (paste) văn bản 

Các thao tác sao chép văn bản được thực hiện thông qua một vùng nhớ trung gian gọi là 

Clipboard. Sử dụng Clipboard có thể dễ dàng thực hiện các thao tác sao chép, cắt và dán 

một đoạn văn bản, một hình ảnh, một đối tượng, ... và có thể hồi phục các trạng thái 

thực hiện. 

Các thao tác sao chép, di chuyển và xoá văn bản chỉ được thực hiện trên các đối tượng 

văn bản đã được chọn. 

Thao tác sao chép/dán đối tượng văn bản 
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 Chọn đối tượng văn bản. 

 Vào thanh lệnh chọn Home --> Copy. 

 Di chuyển con trỏ văn bản đến nơi cần sao chép. 

 Vào thanh lệnh chọn Home --> Paste 

  

Nút lệnh Copy (hoặc dùng tổ hợp phím Ctrl+C) Nút lệnh Paste (hoặc dùng tổ hợp phím Ctrl+V) 
 

 

Thao tác di chuyển đối tượng văn bản 

Đối tượng được chuyển vào bộ đệm, trên màn hình đối tượng không còn nữa. 

 Chọn đối tượng văn bản. 

 Vào thanh lệnh chọn Edit --> Cut. 

 Di chuyển con trỏ văn bản đến nơi cần sao chép. 

 Vào thanh lệnh chọn Edit --> Paste 
 

 
Nút lệnh Cut (hoặc dùng tổ hợp phím Ctrl+X) 

 

 

Di chuyển giữa các cửa sổ soạn thảo 

MS-Word cho phép ta mở và soạn thảo nhiều tài liệu một lúc. 

Mỗi tài liệu được hiển thị và soạn thảo trong một cửa sổ riêng. Khi mở tài liệu mới 

thông thường chúng hiển thị đầy màn hình nên cửa sổ khác bị che khuất. 

Để xem và chuyển cửa sổ soạn thảo từ tài liệu này sang tài liệu khác hãy thực hiện: 

Thao tác nhanh: 

+ Khi có nhiều cửa sổ chương trình làm việc có thể sử dụng tổ hợp phím Alt-Tab để 

chuyển đổi cửa sổ một cách nhanh chóng. 
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+ Có thể nhìn thấy các thanh cửa sổ thu nhỏ ở thanh trạng thái cuối màn hình chính. 

Bấm chọn tên trên các thanh thu nhỏ sẽ mở được cửa sổ để làm việc. 

 
 

Thực hành nâng cao kỹ năng soạn thảo văn bản 

(1) Chèn một hoặc nhiều khoảng trắng giữa hai kí tự. 

(2) Xóa một hoặc nhiều khoảng trắng giữa hai kí tự. Sửa chữa một kí tự. 

(4) Chèn khoảng trống trước 1 dòng. Xóa bỏ các khoảng trống đó. 

(5) Tách một dòng văn bản thành hai dòng 

(6) Nối hai dòng đã tách thành 1 dòng. 

(7) Chèn một hoặc nhiều dòng trống giữa hai dòng. 

(8) Xóa dòng trống giữa hai dòng. 

(9) Lựa chọn đối tượng, thao tác sao chép/cắt và dán văn bản. 

(10) Mở hai cửa sổ văn bản mới. Gõ một số dòng văn bản. Thực hiện sao chép nội dung 

giữa hai cửa sổ văn bản. 
 

Thay đổi cách hiển thị tài liệu 

Có bốn cách hiển thị tài liệu gồm: Read Mode, Print Layout, Web Layout và Outline 

 
 

 

Hình. Các chế độ xem tài liệu 
 

 

Cách thực hiện 

Cách 1: Bấm mục View --> chọn một cách hiển thị 

Cách 2: chọn một trong bốn biểu tượng hiển thị ở góc phải dưới màn hình 

 
 

 

Hình. Các chế độ xem tài liệu, hiện đang trỏ đến chế độ Print Layout 

Các chế độ 

xem tài liệu 

Các chế độ 

xem tài liệu 
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HHiiểểnn  tthhịị  tthhaannhh  tthhưướớcc 

Bấm chọn mục View làm xuất hiện hộp chọn Ruler. Nếu chưa có thanh thước ngang 

xuất hiện trong cửa thì bấm chọn mục Ruler. 

 
 

Chọn Rule để 

hiển thị 

thước 
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Các tiện ích nâng cao 

CChhèènn  tthhêêmm  kkíí  hhiiệệuu  ((SSyymmbbooll)) 

Ví dụ: Trong văn bản soạn thảo, ta có thể chèn thêm các mẫu tự không thể gõ từ bàn 

phím như  .. các kí hiệu toán học như  .. , các kí hiệu khác như: 

 ... 

Chèn các ký tự này theo các bước sau : 

 Đặt con chạy tại vị trí cần chèn vào. 

 Trên thanh lệnh Insert --> chọn mục Symbol.  

 

 Chọn More Symbols, trong bảng Symbol chọn phông Wingdings (hay 

các phông khác) để xuất hiện các ký hiệu cần dùng. Chọn kí hiệu và 

nhấn nút Insert và Close để kết thúc việc chèn kí hiệu. 

Chương 

2 
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Thực hành: 

Chèn một số kí hiệu minh họa vào tệp văn bản 

Đổi phông để được 

các kiểu dạng ký 

hiệu khác nhau 
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GGõõ  ddạạnngg  kkíí  ttựự  cchhỉỉ  ssốố  ttrrêênn//  ddưướớii 

Trong văn bản soạn thảo có thể nhập công thức toán học như biểu thức x
2
y

2   
hay H2O. 

Cách gõ kí tự chỉ số trên: 

+ nhấn tổ hợp phím :  Ctrl- Shift - = (để chuyển sang trạng thái gõ chỉ số trên khi đó 

con trỏ sẽ chuyển sang dạng dòng cao hơn dòng bình thường) 

+ nhập kí tự chỉ số trên. Ví dụ như số 2 trong phương trình 

+ nhấn lại tổ hợp phím :  Ctrl - Shift - =  (để chuyển về trạng thái bình thường) 

Cách gõ kí tự chỉ số dưới: 

+ nhấn tổ hợp phím :  Ctrl - = (để chuyển sang trạng thái gõ chỉ số dưới khi đó con 

trỏ sẽ chuyển sang dạng dòng thấp hơn dòng bình thường) 

+ nhập kí tự chỉ số dưới. Ví dụ như số 2 trong công thức hoá học. 

+ nhấn lại tổ hợp phím :  Ctrl - =  (để chuyển về trạng thái bình thường) 

Thực hành: 

Gõ thêm những dòng công thức toán học, hoá học vào tệp văn bản. Sao lưu kết quả làm được. 

 

HHiiểểnn  tthhịị  ccáácc  kkíí  ttựự  đđặặcc  bbiiệệtt 

Trên thanh công cụ Home có nút  cho phép hiển thị/che dấu các kí tự đặc 

biệt. Để biết được chính xác chức năng của này chỉ cần nhấn nút và xem sự thay 

đổi văn bản đang soạn thảo. Bấm một lần nữa lên nút sẽ đặt văn bản về trạng thái 

bình thường. 

CChhèènn  ddấấuu  nnggắắtt  ttrraanngg 

MS-Word tự động tạo trang mới khi dòng văn bản vượt quá số dòng theo định 

dạng trang được đặt trong Page Setup. Thế nhưng trong văn bản người dùng lại 

có nhu cầu ngắt trang mỗi khi nội dung văn bản đã kết thúc một chương và soạn 

thảo trang đầu tiên của chương mới. 

Thao tác: 

 Đặt con trỏ văn bản tại vị trí cần sang trang. 

 Nhấn chọn thực đơn Insert->Page Break. 

Thao tác nhanh: Sử dụng tổ hợp phím tắt Ctrl-Enter để tạo ngắt trang. 
 

Thực hành: 

+ Gõ dòng văn bản tuy ý trên các trang để có khái niệm về trang. 

+ Thu nhỏ khung nhìn 25% và xem các trang được hiển thị thế nào. 

+ Sao lưu kết quả làm được. 

 

HHuuỷỷ  bbỏỏ  nnggắắtt  ttrraanngg 

Việc huỷ bỏ ngắt trang đơn giản chỉ là việc xoá kí tự ngắt trang. 
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Đặt con trỏ tại dòng cuối của trang trên và bấm phím Delete liên tục cho đến khi các 

dòng của trang dưới được di chuyển lên trang trên. 

Thực hành: 

+ Thu nhỏ khung nhìn soạn thảo là 25%. Đếm số trang hiện có. Đặt lại khung nhìn 100%. 

+ Tạo thêm trang mới. Xoá bỏ trang cuối cùng. 

 

CChhèènn  ssốố  ttrraanngg 

MS-Word   cho phép tự động đánh số trang văn bản. Khi chỉnh sửa văn bản, số trang 

được thay đổi theo, rất tiện lợi cho người sử dụng. 

Cách thực hiện: 

+ Nhấn chọn thực đơn Insert -> Page Numbers. Hộp thọai xuất hiện như hình minh họa. 

 
 

- Nhấn chuột lựa chọn đặt số trang ở tiêu đề đầu trang (top of page) hay ở tiêu 

đề chân trang (bottom of page)… 

- Sau đó lựa chọn cho phép đặt số trang ở phía trái, phải hay giữa trang. 

dấu gạch không 

liền nét thể hiện 

ngắt trang 
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+ Bấm vào nút Format Page Number để xuất hiện hộp thoại 

 
 

- Mục Number format: cho phép người dùng chọn kiểu chỉ số là số nguyên hay 

số La mã, chữ cái. 

- Mục Page numbering: có danh sách một lựa chọn cho phép người dùng hoặc là 

đặt theo số trang nối tiếp nhau (lựa chọn Continue from previous section) hoặc 

theo một con số tự đặt (lựa chọn Start at). 

Lưu ý: Muốn xoá số trang đã thực hiện chọn mục Remove Page Numbers 

Thực hành: 

+ Thu nhỏ khung nhìn soạn thảo là 25%. Đếm số trang hiện có. Đặt lại khung nhìn 100%. 

+ Thực hiện chèn số trang theo các tuỳ chọn. Mỗi tuỳ chọn cần kiểm tra bằng cách xem số trang 

được đánh số trên văn bản. 
 

 

CChhứứcc  nnăănngg  ttììmm  kkiiếếmm 

Nhấn chọn thực đơn lệnh Home->Find.   

 

- Tìm kiếm đơn giản chọn Find 

- Tìm kiếm nâng cao chọn Advanced Find. Hộp thoại tìm kiếm xuất hiện. 

Thẻ File 

* Ô Find what là nơi nhập mẫu từ cần tìm kiếm 
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Trong phần Search Options 
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* Danh sách chọn Search cho phép chọn phạm vi tìm kiếm. 
 

 
* ô chọn Match case: Nếu ô này được đánh dấu chọn, sẽ tìm kiếm cụm từ theo đúng từng 

chữ, có phân biệt ký tự hoa và thường, nếu không thì có nghĩa là ký tự được tìm kiếm không 

phân biệt chữ hoa hay thường. 

* ô chọn Find whole words only: Khi mẫu tìm kiếm là một từ thì chúng ta thấy ô này xuất 

hiện. Nếu ô này được đánh dấu chọn thì các từ trong văn bản phải trùng với mẫu tìm kiếm 

mới được nằm trong danh sách kết quả, nếu không thì các từ trong văn bản có chứa mẫu tìm 

kiếm cũng được nằm trong danh sách kết quả. 

* Thẻ Replace 

  

CChhứứcc  nnăănngg  tthhaayy  tthhếế 

*  Nhấn chọn thực đơn lệnh Home->Replace.   

 

 
 

Nhập mẫu từ cần tìm trong ô Find what và nhập mẫu từ cần thay thế trong ô Replace 

- chọn mục Down để giới hạn tìm kiếm từ vị trí con 

trỏ văn bản hiện tại đến cuối văn bản 

- chọn mục Up để giới hạn tìm kiếm từ vị trí con trỏ 

văn bản hiện tại lên đầu văn bản 

- chọn mục All để chỉ định tìm kiếm trên toàn bộ 

nội dung văn bản. 
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with. 

Thực hiện việc tìm kiếm và thay thế 

* Nhấn nút Replace hoặc Find Next để bắt đầu việc tìm kiếm và thay thế. 

* Nếu có cụm từ trong văn bản được tìm thấy, chúng ta sẽ thấy cụm từ đó xuất hiện ở 

dạng nền đảo màu. 

 
 

Sử dụng các nút như sau: 

- nút Replace để đồng ý thực hiện thay thế theo kết quả của mỗi lần tìm kiếm. 

- nút Replace All để chương trình tự động thực hiện tìm kiếm và thay thế trên 

toàn văn bản. 

- nút Find Next để thực hiện tiếp tìm kiếm, bỏ qua trạng thái hiện tại và không 

thực hiện việc thay thế. 
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- nút Cancel để ngừng tìm kiếm và đóng hộp thoại. 

Trong khi tìm kiếm, hộp thoại Find and Replace vẫn ở trạng thái nổi trên cửa sổ văn 

bản cho phép thao tác tiếp với các nút. Quá trình tìm kiếm sẽ được kết thúc khi đã thực 

hiện xong tất cả yêu cầu mà người sử dụng đã chọn. 

Thẻ Go To - cho phép di chuyển nhanh con trỏ văn bản 
 

 

Phần Go to what: cho phép chọn lựa Page (trang), Line (dòng),.. 

Phần Enter page number: cho phép nhập con số chỉ vị trí di chuyển. Theo hình minh 

họa thì con số 25 có ý nghĩa là trang số 25 của văn bản. Có thể gõ thêm dấu cộng (+) để 

chỉ định là di chuyển đi lên phía đầu văn bản hoặc gõ thêm dấu trừ (-) để chỉ định di 

chuyển về phía cuối văn bản. 

Nhấn nút Go To để thực hiện việc di chuyển nhanh con trỏ văn bản đến vị trí được xác 

định. 



25  

 

 
 

 

 

Định dạng văn bản 

Định dạng kí tự 

Định dạng kí tự được thể hiện qua hộp thoại Font. Thao tác như sau: 

+ Nhấn chọn thực đơn lệnh Home --> Font 

  
 

Hình 30. Hộp thoại Font với thẻ Font Hình 31. Hộp thoại Font với thẻ Advanced 

 

Thẻ Font - (gọi là phông) 

 Thẻ Font chứa hầu hết các chức năng định dạng đã nói ở trên. Có thể đổi 

màu chữ, màu nền bằng danh sách chọn Font Color. 

Chương 

3 
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Định dạng đoạn văn bản (paragraph) 

Khái niệm: Một đoạn văn bản gồm một hoặc nhiều dòng văn bản được kết thúc bằng một kí 

tự đặc biệt gọi là kí tự đánh dấu đoạn, có hình ảnh hiển thị là . 

Bấm nút  trên thanh công cụ Home để hiển thị kí tự đánh dấu đoạn. 

Các thao tác định dạng cho đoạn văn bản được thể hiện đầy đủ trong hộp thoại Paragraph. 
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Hình 33. Hộp thoại Paragraph 

 

- Alignement: Chọn một trong các lựa chọn căn lề trái (left), phải(right), giữa(centrered) 

và hai bên(justify). 

- Identation left/right:  đặt khoảng cách từ lề trái / phải đến kí tự ngoài cùng bên trái / 

phải của đoạn văn bản. 

- Special - căn chỉnh dòng đầu tiên (first line) có thể thụt lề trái hơn nữa so với cả đoạn. 

- Spacing before/after: đặt giãn cách dòng trước khi bắt đầu đoạn văn bản và sau khi kết 

thúc đoạn (để sang đoạn khác). 

- Line spacing : đặt giãn cách giữa các dòng trong đoạn văn bản đó là đơn (single), gấp đôi 

(double) hay gấp rưỡi (1.5 line) ... 
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Lưu ý: 

+ Sau khi gõ dòng văn bản và nhấn phím Enter, một đoạn văn bản được xác định và con 

trỏ văn bản xuống dòng để nhập dòng văn bản mới. 

+ Trong khi gõ dòng văn bản và nhấn tổ hợp Shift-Enter, đoạn văn bản chưa kết thúc chỉ 

có con trỏ văn bản xuống dòng để nhập tiếp. Vậy không thể dựa theo việc xuống dòng để 

xác định một đoạn văn bản đã kết thúc hay chưa. 

Thực hành: 

+ Mở tệp văn bản và gõ văn bản sau. Yêu cầu nội dung được nhập chỉ là ba đoạn văn bản mà thôi. 
 

 

 

+ Thực hiện định dạng kí tự: thay đổi phông chữ, cỡ chữ, màu sắc chữ, in nghiêng/đậm/gạch chân 

+ Sử dụng tổ hợp phím Shift+Enter để chỉ tạo ra ba đoạn văn bản. 

+ Thực hiện định dạng đoạn văn bản: mỗi dòng cách nhau 1.5line, mỗi đoạn cách dòng trên 6pt 

+ Đoạn thứ nhất  được căn lề phải, đoạn thứ hai được căn lề phải, đoạn thứ ba được căn 

giữa. 

 

 

Riêng điều ấy không bao giờ anh biết cả 

một lần em lỡ hẹn với anh 

Chiều vắng xanh nơi gúc phố xanh  

em đến gần cánh cửa xanh hộ mở... 
Bên bậc cửa có một đôi guốc đỏ 

đôi chân em sao khó bước qua 
chỉ một bước thôi là hết cách xa 

  anh gần lắm... phía bên kia đôi guốc 

Chẳng biết vì sao chân em lùi bước chiều 

đương xanh bên cánh cửa xanh  

có lẽ nào  em lỡ hẹn cùng anh 

đôi guốc đỏ biết rằng em đã tới... 
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M ộ t   s ố   p h í m   t ắ t   c ơ   b ả n 







Ctrl + B : Bật tắt chế độ viết chữ đậm. 

Ctrl + I : Bật tắt chế độ viết chữ nghiêng 

Ctrl + U: Bật tắt chế độ viết chữ có gạch 

chân 

Ctrl + L: Căn lề trái 

Ctrl + R: Căn lề phải 

Ctrl + E: Căn giữa 

Ctrl + J: Căn hai bên (trái lẫn phải) 









TThhaannhh  ccôônngg  ccụụ  FFoorrmmaattiinngg 

Việc định dạng các đối tượng văn bản 

được chọn có thể thao tác nhanh qua 

thanh công cụ. 
 

 

 

 

 

 

 

 

 

Trên thanh công cụ Home (xem hình dưới) có các nút chức năng cơ bản: 

 
 

 

Hình 29. Thanh công cụ Formatting 

 

Giải thích các nút: 

 Kiểu dạng văn bản (style). 

 Nút hiển thị phông chữ đang sử dụng. Nút này cho phép chọn phông chữ 

chuyển đổi cho phần văn bản đã được chọn. 

 Nút hiển thị cỡ chữ đang sử dụng và cho phép thay đổi cỡ chữ (cho phần văn 

bản được chọn) . Có thể chọn cỡ theo danh sách hoặc có thể gõ trực tiếp cỡ 

chữ không có trong danh sách. 

 Bật / tắt chế độ chữ đậm. 

 Bật / tắt chế độ chữ nghiêng. 

 Bật / tắt chế độ chữ gạch chân. 

 Căn lề trái văn bản. (phím tương đương là Ctrl - L) 

 Căn lề giữa văn bản. (phím tương đương là Ctrl-E) 

 Căn lề phải văn bản. (phím tương đương là Ctrl -R) 

 Căn lề cả trái lẫn phải. (phím tương đương là Ctrl -J) 

 Đánh chỉ số tự động cho mỗi đoạn văn bản 

 Đặt các nút danh sách liệt kê 

 Dịch cả đoạn văn bản sang bên phải 1 Tab 

 Dịch cả đoạn văn bản sang bên trái 1 Tab 

Thao tác nhanh: 
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Ctrl+[ 

Ctrl+] 

+ Tổ hợp phím 

+ Tổ hợp phím 

: giảm cỡ chữ cho đối tượng văn bản theo tuyến tính. 

: giảm cỡ chữ cho đối tượng văn bản theo tuyến tính. 
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SSaaoo  cchhéépp  đđịịnnhh  ddạạnngg 

Trên thanh công cụ Home có nút Format Painter (hình dạng ). Chức năng 

của nút này là sao chép định dạng của một đối tượng và chuyển định dạng đó vào đối 

tượng được chọn khác. 

Cách thực hiện: 

- Chọn một đối tượng văn bản 

- Bấm một lần lên nút Format Painter. Sau đó đi chọn các đối tượng muốn chuyển định dạng 

và tự động kết thúc việc chuyển định dạng. 

Để có thể làm nhiều lần sao chép định dạng mà không cần xác định lại đối tượng gốc thì 

nhắp đúp chuột lên nút Format Painter. Khi muốn kết thúc việc chuyển định dạng phải nhắp 

chuột lên nút Format Painter. 
 

Định dạng chung 

SSửử  ddụụnngg  vvàà  tthhiiếếtt  llậậpp  ddấấuu  TTaabb  đđểể  ccăănn  llềề  đđooạạnn  vvăănn  bbảảnn 

Dấu Tab là một kí tự đặc biệt được đặt trên thanh thước kẻ cho phép căn lề trái / phải một 

đoạn văn bản hoặc tạo các dòng kẻ gồm các kí hiệu dấu chấm (.) hoặc dấu gạch ngang (-). 
 

 
 

 

1. Đặt Tab thông thường 

 Bước 1: Nhấn vào biểu tượng dấu Tab ở đầu mút trái của thanh thước kẻ 

cho đến khi hiện biểu tượng dấu Tab thích hợp. Có các loại Tab sau: trái 

, phải , giữa , thập phân , thanh ngăn  

 Bước 2: Nhấn chuột vào vị trí đặt Tab trên thanh thước. 

điều chỉnh lề 

cho dòng 

thứ 1 của 

đoạn văn 

bản 

biểu 

tượng 

Tab 

điều chỉnh lề các 

dòng của đoạn văn 

bản (trừ dòng thứ 1) 
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2. Thiết lập bảng Tab 

 

 Bước  1:  Chọn thực đơn  Home -

-> Paragraph trong bảng 

Paragraph chọn nút Tab… 

 Bước 2: Đặt vị trí cho dấu Tab 

trong ô Tab stop position 

 Bước 3: Chọn kiểu căn lề cho 

đoạn văn bản sau dấu Tab tại ô 

Alignment 

 Bước 4: Chọn kí tự đặt trước 

dấu Tab tại ô Leader 

(Xem hình bên) 
 

 

3. Xóa thiết lập Tab 

 

 

Hình. Đặt Tab có kí hiệu phía trước 

 

 

 Bước 1: Chọn lệnh Tabs trong bảng chọn Format 

 Bước 2: Chọn mục Clear hoặc Clear All để xóa các giá trị đã thiết lập cho 

phím Tab. 
 

 

 

Danh sách liệt kê 

DDaannhh  ssáácchh  kkhhôônngg  đđáánnhh  ssốố  tthhứứ  ttựự  vvàà  ddaannhh  ssáácchh  ccóó  đđáánnhh  ssốố  tthhứứ  ttựự 

Danh sách không đánh số thứ tự là một dãy liên tiếp các đoạn văn bản được đánh dấu bằng các 

gạch đầu dòng, các chấm tròn, dấu sao hay nhiều kiểu dấu hiệu khác 

Nếu dãy liên tiếp các đoạn văn bản được liệt kê bằng cách thêm một số thứ tự 1,2,3,4 .. hay 

a,b,c,d, ... tại điểm đầu dòng của mỗi đoạn văn bản thì ta có danh sách có đánh số thứ tự. 

Có nhiều cách để tạo danh sách: 

 Nhấn vào nút Bullets hay Numbering trên thanh công cụ Home 
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 Sử dụng tính năng AutoFormat để tạo Bullets khi đang gõ văn bản 

 Chọn lệnh Bullets and Numbering từ bảng chọn Home để chèn hoặc thay 

đổi định dạng của Bullets và Number list 
 

TTạạoo  ddaannhh  ssáácchh  bbằằnngg  nnúútt  llệệnnhh  ttrrêênn  tthhaannhh  ccôônngg  ccụụ 

 Bôi đen toàn bộ các đoạn văn bản thuộc danh sách. 

 Nhấn vào nút chức năng Bullets  để tạo danh sách không có số thứ tự 
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 Nhấn vào nút chức năng Numbering để tạo danh sách có đánh số thứ 

tự 
 

 

TTạạoo  ddaannhh  ssáácchh  kkhhôônngg  đđáánnhh  ssốố  tthhứứ  ttựự  bbằằnngg  hhộộpp  tthhooạạii  BBuulllleettss  aanndd  NNuummbbeerriinngg 

 Di chuyển con trỏ văn bản tới đầu danh sách cần liệt kê. 

 Chọn thực đơn lệnh Home chọn nút Customize để chọn các kí tự khác (mũi tên) 

. 

 Lựa chọn một trong các kiểu danh sách có sẵn.  

 
 

Hình . Thay đổi đề mục trong danh sách không đánh số Bullet 

 

TTạạoo  ddaannhh  ssáácchh  đđáánnhh  ssốố  tthhứứ  ttựự  bbằằnngg  hhộộpp  tthhooạạii  BBuulllleettss  aanndd  NNuummbbeerriinngg 

 Di chuyển con trỏ văn bản tới đầu danh sách cần liệt kê. 

 Chọn  thực  đơn  lệnh  Format  -->  Bullets  and  Numbering.  Mở  thẻ 

Numbered. Nếu muốn tạo danh sách được đánh số thứ tự thì chọn thẻ 

Numbered. 
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 Để đánh chỉ số không theo chỉ số đã có ở dòng trên thì chọn Restart new list. Khi 

đó chỉ số được đánh lại bắt đầu từ số 1. 

 
 

Thay đổi Style của văn bản 

Trong một cuốn tài liệu, mỗi tiêu đề chương mục cần có một định dạng chung khác với nội 

dung chi tiết được viết ra. Điều đó giúp cho chúng ta có thể xây dựng được một bảng mục 

lục tự động bằng chức năng Insert Index and Tables của MS-Word. 

Cách thực hiện 

- Chọn văn bản và chọn Style thích hợp ở ô Style trên thanh công cụ 
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Tạo bảng mục lục tự động 

Trong một tài liệu có áp dụng Style cho các chương mục thì việc tạo bảng mục lục tự động 

sẽ rất dễ dàng. 

Chọn mục References --> chọn thẻ Table of Contents. 
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Khuôn dạng tài liệu mẫu (template) 

KKhhááii  nniiệệmm  ttààii  lliiệệuu  mmẫẫuu  ((tteemmppllaattee)) 

Mọi văn bản trong Microsoft Word đều được xây dựng dựa trên các khuôn mẫu nào đó mà ta 

gọi là Template. Đó là những tệp tin chứa các cấu trúc và công cụ dùng để định dạng thuộc tính 

của một tài liệu như kiểu dáng, phông chữ, cách bố trí các phần trong tài liệu… MS-Word có rất 

nhiều khuôn mẫu định sẵn cho 7  loại tài liệu khác nhau, đó là: Business, Industry, 

Personal, Design Sets, Event, Education, Labels. 

TTạạoo  mmớớii  mmộộtt  tteemmppllaattee 

 Bước 1: Mở một tệp văn bản mới. Gõ nội dung mẫu, ví dụ tiêu đề của 1 

công ty. 

 Bước 2: Chọn File / Save as . Trong hộp thoại Save as Type, chọn 

Document Template. Đặt tên cho mẫu văn bản đó, xác định đường dẫn rồi 

nhấn OK. 
 

SSửử  ddụụnngg  tteemmppllaattee  đđãã  ttạạoo 

 Bước 1: Vào thực đơn lệnh File --> New. 

 Bước 2: Chọn tên Template đã tạo (không chọn mẫu sẵn có là Blank 

Document) 

Văn bản mới sẽ có những dòng văn bản mẫu xuất hiện. Ngoài ra có thể chọn những mẫu 

Template mà MS-Word đã cung cấp để soạn nhanh các văn bản tiếng Anh đúng chuẩn quốc 

tế. 
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Hoa 

sữa 

 

Đường viền và dạng nền cho văn bản 

Sử dụng thực đơn Home chúng ta có thể thay đổi đường viền và dạng nền cho các đối 

tượng văn bản được chọn. 

Ví dụ minh họa 

không biết được du nhập vào Hà Nội từ bao giờ, cây cao, dáng đẹp, thân mốc 

thếch, cao tới gần 20m, cành đan xen khúc khuỷu. Cây hoa sữa không có mùa trút lá, chỉ lác 

đác rụng lá vàng, nên suốt năm cây luôn xanh tốt. 

Cách thực hiện 

 Bước 1: Chọn đối tượng văn bản 

 Bước 2: Chọn thực đơn Home --> Chọn loại đóng khung có sẵn  

 
 

 Hoặc chọn Borders and Shading làm xuất hiện hộp định dạng: 

 Trong thẻ Borders thực hiện việc chọn đường bao, cỡ đường bao, màu đường bao. 
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 Trong thẻ Page Border có thể chọn đường bao cho cả trang văn bản 
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 Trong thẻ Shading có thể chọn dạng nền cho văn bản 
 

 

Thao tác nhanh: 
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Ngòai việc chọn lệnh trên thanh lệnh, chúng ta có thể sử dụng lệnh tương ứng trong cửa sổ 

lệnh có được khi nhắp nút phải chuột lên đối tượng chọn. 
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M ộ t   s ố   t h u ộ c   t í n h   c ủ a   b ả n g  









Number of Columns : Số cột. 

Number of Rows : Số dòng 

Fixed column width: Cố định độ rộng của 

cột AutoFit to contents: Tự động co dãn 

theo số lượng dữ liệu 

AutoFit to window: Tự động co dãn theo 
cửa 

sổ mở tài liệu 



 

 
 

 

 

Bảng biểu và hình ảnh 

Trong MS-Word, nên phân loại các đối tượng như sau để dễ học cách xử lý: văn bản, bảng 

biểu và hình ảnh. 
 

Bảng biểu 

Cần phân biệt hai thành phần của bảng: khung của bảng và nội dung trên từng ô của bảng. 

Tên gọi mỗi thành phần của khung: 

Tên gọi tiếng Việt Tên gọi tiếng Anh 

ô Cell 

cột Column 

dòng Row 

Các lệnh thao tác trên khung và nội dung hoàn toàn khác nhau. 

TTạạoo  kkhhuunngg  bbảảnngg  bbiiểểuu 

Có hai cách tạo khung bảng biểu: 

 Mở bảng chọn 

Insert chọn Table 

và chọn Insert 

Table. Hộp thoại 

Insert Table hiện ra 

yêu cầu nhập số cột, 

số hàng của bảng. 

 Hãy đặt số cột của 

bảng    trong    phần 

Number of columns, số hàng của bảng trong phần Number of rows, sau đó 

chọn nút OK. 

Chương 

4 
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 Một hộp lựa chọn cho phép nhập số hàng và số cột yêu cầu. 
 

 

Hình 46. Tạo một bảng biểu có 5 cột, 2 dòng 

 

Thao tác nhanh 

 Có thể sử dụng nút tạo bảng trực quan hơn. Nhấn chuột vào biểu tượng 

Insert table, một khung kẻ ô lưới sẽ hiện ra cho phép dùng chuột để chọn số 

hàng số cột của bảng. 

 
 

 

 

Phần nội dung 

NNhhậậpp  nnộộii  dduunngg 

Hình 47. Tạo bảng biểu gồm 3 dòng, 5  cột 

 Chuyển đổi qua lại giữa các ô: Di chuyển con trỏ chuột, dùng phím Tab 

hoặc phím mũi tên. 

 Việc nhập nội dung văn bản, sau đó định dạng văn bản được thực hiện như 

đã trình bày tại phần văn bản. 
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SSaaoo  cchhéépp//ccắắtt//ddáánn//xxooáá  nnộộii  dduunngg 

 Hoàn toàn có thể sao chép/cắt /dán và xoá nội dung văn bản trên các ô như 

đã trình bày tại phần văn bản. 

 Thao tác xoá nội dung của trên ô/dòng/cột không làm mất ô/dòng/cột của 

bảng. 
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Phần khung 

TThhaaoo  ttáácc  cchhọọnn  ôô//ccộộtt//ddòònngg  ccủủaa  bbảảnngg 

 Chọn một hoặc nhiều ô của bảng bằng cách di chuyển con trỏ chuột (hình 

mũi tên đen xuất hiện như trong hình minh hoạ) đến ô và bấm chọn. 

 Bấm chọn một ô và kéo chuột đến các ô khác để chọn nhiều ô. 
 

 

 

 

TThhaaoo  ttáácc  cchhíínnhh  xxáácc:: 

Khi chọn nhiều ô/dòng/cột cần phải thao tác chính xác như sau: 

 Chọn ô đầu tiên 

 Giữ phím Shift và chọn ô cuối cùng trên dãy các ô muốn chọn. 
 

TThhaaoo  ttáácc  cchhọọnn  nnhhaannhh  11  ccộộtt//11ddòònngg:: 

+ Đưa con trỏ chuột lên đầu cột (hay đầu dòng) khi đó hình mũi tên xuất hiện như hình 

minh hoạ và bấm chọn. Cả cột hoặc cả dòng được chọn. 
 

 

 

 
 

 

Thao tác nhanh 

Để việc sao chép/cắt/dán/xoá  nội dung được thực hiện nhanh hơn cần thực hiện thao tác 

chọn khung trước. 

Ví dụ: Chọn nội dung của ô đầu tiên trên 1 cột, nhấn nút sao chép. Thực hiện chọn các ô 

tiếp theo của cột, nhấn nút dán nội dung lập tức nội dung được sao chép lên các ô tiếp theo. 

Tương tự có thể xoá nhanh các nội dung của 1 cột bằng cách chọn 1 cột và nhấn phím 

Delete. 
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TThhaaoo  ttáácc  cchhèènn//xxooáá//cchhỉỉnnhh  ssửửaa  ttrrêênn  kkhhuunngg 

 Thêm hàng(hoặc cột):  Đặt con trỏ tại vị trí hàng (hoặc cột) cần thêm, chọn 

trên thanh lệnh Layout của Table Tools để chèn Rows & Column (như hình). 
 

 

 Xóa ô/cột/dòng/bảng: Đặt con trỏ tại vị trí hàng (hoặc cột) cần xóa, chọn 

trên thanh lệnh Layout của Table Tools và chọn Delete để xóa Rows & 

Column (như hình). 

 

 Xoá một hoặc nhiều ô: Chọn các ô, sau đó kích nút phải chuột để xuất hiện 

hộp lựa chọn như hình minh hoạ và chọn Delete Cells. 
 

 

Hộp thoại chọn lựa phương án xoá xuất hiện: 

+ Chọn Shift Cell Left để xoá ô chọn và dịch chuyển các ô bên phải sang trái để điền 

vào chỗ trống. 

+ Chọn Shift Cell Up để xoá ô chọn và dịch chuyển các ô phía dưới lên điền vào chỗ 

trống. 

+ Delete entire row để xoá cả dòng đang chứa ô chọn và dịch chuyển các dòng phía 

dưới lên điền vào chỗ trống. 

+ Delete entire column để xoá cả cột đang chứa ô chọn và dịch chuyển các cột phía 

bên phải sang trái điền vào chỗ trống. 
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Tổng kết: 

Khi xoá khung của bảng thì nội dung trong khung bị xoá theo, nhưng xoá nội dung 

trong khung thì không làm mất khung của bảng. 

 Xoá dữ liệu trong bảng: Bôi đen vùng dữ liệu cần xoá, nhấn phím Delete. 

 Nếu nhấn phím Enter thì ô sẽ rộng thêm một dòng, xoá dòng trống sẽ thu 

hẹp dòng. 

 Thêm một hàng vào cuối bảng: Đưa con trỏ về ô cuối cùng của bảng, nhấn 

phím Tab. 

 Điều chỉnh độ rộng, hẹp các cột: Đưa con trỏ vào đường phân cách giữa các 

cột, khi nó có hình thì kéo-thả để thay đổi độ rộng cột. 

 Nhập (Merge) và tách (Split) ô: 

+ Trước tiên chọn các ô 

+ Nhắp chuột phải trên đối tượng chọn để làm xuất hiện hộp lựa chọn. 

+ Chọn mục Merge Cells để nhập nhiều ô thành 1 ô. Thao tác tách bảng thực hiện tương 

tự 
 

 

Trong hình minh hoạ các ô như Stt, Họ tên, Điểm là những ô được nhập lại từ 2 ô. 

Hộp lựa chọn lệnh khi thao tác với bảng 
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Thao tác nhanh bằng thanh công cụ 

Có thể thực hiện được các thao tác trên khung của bảng qua thanh công cụ có tên là Design 

ở trong Tables Tools.  

 

Hoặc thao tác với bảng có tên là Layout ở trong Tables Tools.  

 

Muốn hiển thị thanh công cụ Design và Layout ở Tables Tools chỉ cần đưa con trỏ vào bảng 

khi đó Tables Tools sẽ xuất hiện. 

Trong hình trên ở Layout có hai chức năng rất tiện ích khi thao tác với nội dung của bảng đó 

là: Text Direction và Cell Alignment 

 

 

Text Direction Cell Alignment 
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MMởở  rrộộnngg//tthhuu  hhẹẹpp  ccộộtt  vvàà  ddòònngg 

Sử dụng nút phân cách cột trên thanh thước có chức năng khác hẳn so với sử dụng dịch 

chuyển cột qua đường phân cách. 
 

 
 

 

Bảng so sánh 
 

Đường phân cách Nút phân cách 

+ khi di chuyển 1 đường phân cách sang 

phải thì chỉ có các cột chung đường phân 

cách thay đổi độ rộng. Các cột khác không 

di chuyển vị trí. 

+ nhắp đúp chuột trái vào đường phân 

cách, độ rộng của cột được tự điều chỉnh 

vừa đúng với độ dài văn bản trên các ô, 

tránh được việc đặt độ rộng cột quá lớn. 

+ cho phép chọn lựa 1 ô và điều chỉnh độ 

rộng của chính ô đó, các ô khác không bị 

ảnh hưởng. 

+ khi di chuyển nút phân cách sang phải 

thì làm cho cột tương ứng mở rộng sang 

phải, đồng thời toàn bộ các cột phía phải 

của nút phân cách dịch chuyển theo. 

+ không làm được việc tự điều chỉnh độ 

rộng cột. 
 

 

 

+ tác động lên cả cột. 

nút phân cách 

cột đường phân 

cách cột 
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TTựự  đđộộnngg  cchhỉỉnnhh  đđộộ  rrộộnngg  bbằằnngg  nnhhaauu  cchhoo  ccộộtt//ddòònngg 

Sử dụng chức năng Distribute Rows Evenly và Distribute Columns Evenly để tự động 

chỉnh độ rộng bằng nhau cho cột/dòng. 

Thực hiện như sau: 

+ Chọn nhiều cột/dòng 

+ Kích nút phải chuột làm xuất hiện hộp lựa chọn, sau đó chọn chức năng Distribute Rows 

Evenly (hoặc Distribute Columns Evenly) 

 
 

ĐĐịịnnhh  ddạạnngg  đđưườờnngg  vviiềềnn  cchhoo  bbảảnngg 

Có thể định dạng lại kiểu cách đường viền cho bảng, ví dụ: sử dụng đường viền đậm bao 

quanh bảng, đường viền mảnh kẻ ô. Thao tác như sau: 

 Bước 1: Đặt con trỏ văn bản vào vị trí bất kỳ thuộc bảng biểu. Chọn Design 

trong Table Tools và chọn Borders (như hình) 
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 Bước 2: Chọn mục Borders and Shading trong Borders 
 

 

Hình. Định dạng lại kiểu đường kẻ cho bảng biểu 

 

 Tương tự như thao tác tạo đường kẻ cho trang tài liệu, sau khi lựa chọn dạng 

bảng biểu trong ô Setting, chọn kiểu đường kẻ (mảnh, đứt gãy, gạch 

ngang...), chọn màu đường kẻ (Color), độ dày mỏng (Width), ta nhấn vào 

các nút tương ứng xung quanh ô Preview để thiết đặt vị trí sẽ áp dụng các 

thuộc tính vừa chọn (đường kẻ ngang, dọc, chéo…) 
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Bài thực hành - tạo bảng dạng lịch học như sau: 
 

 

  ĐẠI HỌC QUỐC GIA HÀ NỘI 

TRƯỜNG ĐẠI HỌC CÔNG NGHỆ Thời gian biểu khoá học 

CƠ BẢN VỀ SỬ DỤNG MÁY TÍNH 
 

 
Giờ học : 17h15 - 19h45 

Chủ nhiệm lớp : 
Điều phối viên : 

 

 

Ngày Giờ Nội dung Giảng viên 

Thứ 2 17h15 - 18h00 SOẠN THẢO VĂN BẢN  

22/3  Làm quen với chương trình MS Word 
 - Mở & đóng chương trình 

18h15 - 19h45 - Thao tác lưu tệp, tạo thư mục mới để lưu tệp 

Thứ 3 17h15 - 18h15 Làm quen với chương trình MS-Word  

23/3  - Chỉnh sửa các thiết đặt cơ bản (chế độ xem tài 
 liệu, phóng to và thu nhỏ cửa sổ, hiển thị các 

18h30 - 19h45 nút chức năng trên thanh công cụ) 

Thứ 4 17h15 - 18h15 Làm quen với chương trình MS-Word  

24/3  - Mở nhiều cửa sổ soạn thảo, thu nhỏ cửa sổ 
 soạn thảo, đóng cửa sổ soạn thảo, đóng chương 

18h30 - 19h45 trình. 
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Hình ảnh 

CChhèènn  ttệệpp  ảảnnhh  vvààoo  ttààii  lliiệệuu 

Mỗi ảnh là một tệp riêng biệt. Dán một ảnh vào tài liệu là chèn thêm một tệp vào một chỗ 

nhất định trong tài liệu. Thực hiện thao tác chèn ảnh trong tài liệu như sau: 

 Đặt con trỏ văn bản tại vị trí cần chèn ảnh vào. 

 Nhấn chọn thực đơn lệnh Insert -> Picture. Để xác định tên trong hộp 

File Name, có thể gõ tên (kèm đường dẫn) của tệp ảnh cần chèn hoặc nhấn 

chọn tệp ảnh trong danh sách chọn. Chọn tiện ích Preview để có thể xem 

ảnh trước khi chèn. 
 

 

Hình. Chèn tệp ảnh vào tài liệu hiện hành 

 

 Nhấn nút Insert để kết thúc. 
 

CChhèènn  tthhêêmm  ccáácc  mmẫẫuu  cchhữữ  nngghhệệ  tthhuuậậtt  ssẵẵnn  ccóó  --  WWoorrdd  AArrtt 

Có rất nhiều mẫu chữ trang trí làm sẵn. Để chèn vào các mẫu chữ này vào văn bản, thao tác 

nhấn chọn thực đơn lệnh Insert -> Word Art. 



50  

 
 

Hình . Chọn mẫu chữ nghệ thuật 

 

Sau khi chọn mẫu, khung nhập văn bản hiện ra cho phép nhập dòng chữ. 

 
 

Hình . Nhập dòng chữ nghệ thuật, chọn Font chữ và cỡ chữ trong khung Edit WordArt Text 

 

Sau khi có được một đối tượng WordArt trong tài liệu, có thể thay đổi thuộc tính về màu 

sắc, kiểu dáng,… của đối tượng đó như sau: 

 Nhấn chuột vào đối tượng cần thay đổi. Đối tượng được lựa chọn sẽ có một 

khung viền đen bao quanh 
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Hình. Một ví dụ về chữ nghệ thuật 

 

 Thanh công cụ Format của WordArt hiện ra với các nút lệnh chính có ý 

nghĩa như sau: 
 

 

Hình. Thanh công cụ WordArt 

 

 Chèn thêm một đối tượng WordArt 

 Thay đổi nội dung chữ 

 Chọn lại kiểu chữ nghệ thuật 

 Thay đổi kích thước, màu sắc phối hợp trong đối tượng 

 Thay đổi kiểu uốn lượn của chữ 
 



50  

 
Hình. Thay đổi kiểu cách chữ nghệ thuật 

 

 Đặt thuộc tính Wrap Text 

 Thay đổi chữ ngang thành chữ viết theo chiều dọc 
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CChhèènn  tthhêêmm  ccáácc  hhììnnhh  hhììnnhh  hhọọcc  ssẵẵnn  ccóó  --  AAuuttoo  sshhaappeess 

Chèn các hình vào văn bản: 

Nhấn chọn thực đơn lệnh Insert -> Shapes như minh hoạ bên dưới. 

 
 

Thao tác vẽ như sau: 

 Kích chuột vào hình mẫu cần vẽ. 

 Đưa chuột ra trang giấy và vẽ hình bằng cách kéo- thả chuột. Hình mẫu sẽ tự 
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xuất hiện. 

 Chúng ta có thể chỉnh kích thước, vị trí cho đúng. 

Ví dụ : Chọn mục Callouts và chèn các hình, sau đó soạn thảo các dòng chữ bên trong: 
 

  
 

 

TThhaayy  đđổổii  mmààuu  nnéétt  vvẽẽ,,  ttôô  nnềềnn 

Nhấn phải chuột vào đối tượng AutoShape, chọn lệnh Format Shape… 

Nhấn chọn thẻ Colors and Lines. 

New Idea ! 

Chú ý!!! 
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Hình. Thay đổi màu nét vẽ, màu tô nền 
 

 

 

ĐĐặặtt  ccáácc  tthhuuộộcc  ttíínnhh  cchhoo  hhììnnhh  ảảnnhh 

Hình ảnh được đưa vào văn bản làm cho văn bản thêm sinh động. Có thể điều chỉnh các tuỳ 

chọn của hình ảnh để ảnh làm nền cho văn bản, hình ảnh được văn bản bao quanh, ... 

Cách thực hiện: 

+ Chèn hình ảnh 
 

+ Chọn đối tượng hình ảnh, nhấn phải chuột làm xuất hiện hộp lựa chọn. 
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+ Chọn mục Format Picture 
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+ Trong hộp thoại Format Picture, chọn thẻ Layout 

 
 

Giải thích các thuộc tính trong thẻ Layout: 

+ Chọn In line with text làm cho ảnh và dòng văn bản nằm trên các dòng riêng biệt 

+ Chọn Square làm cho kí tự văn bản bao quanh ảnh theo hình vuông. 

+ Chọn Tight làm cho kí tự của văn bản bao quanh ảnh theo hình dáng của ảnh. 

+ Chọn Behind text làm cho ảnh trở thành nền của văn bản 

+ Chọn In front of text làm cho ảnh nổi lên trên dòng văn bản. Cho phép tạo ra hiệu ứng 

nhiều ảnh ghép được vào nhau.  
 

Thay đổi kích cỡ hình ảnh 

Hình ảnh có thể di chuyển vị trí, phóng to/thu nhỏ kích cỡ của ảnh. 

Cách làm: 

+ Chọn đối tượng hình ảnh làm xuất hiện các nút điều chỉnh kích cỡ.  Bấm chuột vào các 

nút để co giãn hình. 
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Di chuyển/ sao chép/ cắt/dán/xoá hình ảnh 

Có thể thao tác di chuyển/sao chép/cắt/dán/xoá hình ảnh dễ dàng như đã thao tác với văn 

bản. 
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Hoàn tất tài liệu và in ấn 

Tiêu đề đầu trang và tiêu đề chân trang - 

Header / Footer 

TThhêêmm  đđầầuu  ttrraanngg  vvàà  cchhâânn  ttrraanngg  cchhoo  ttààii  lliiệệuu 

Để tạo tiêu đề đầu và chân trang, ta thực hiện các bước sau: mở bảng chọn Insert chọn 

Header/Footer. 

Phần dành cho Header sẽ nổi rõ để ta nhập nội dung của tiêu đề đầu các trang.  Thông 

thường ở đây có tên tắt của tài liệu, tác giả, số trang, ngày tháng .. 

CCáácc  nnúútt  cchhứứcc  nnăănngg 

Các nút chức năng trên thanh công cụ cho phép chèn tự động số trang, ngày giờ. 

 
 

Hình. Thanh công cụ Header and Footer 

 

Các nút như liệt kê dưới đây: 

 Insert Page Number: chèn số trang. 

 Insert Date & Time: chèn ngày tháng và chèn thời gian hiện tại. 

Muốn chuyển xuống phần Footer, ấn vào Go to Footer, tương tự như với Header chọn Go 

to Header, ta có thể soạn thảo phần chân trang của tài liệu. 

Nhấn nút Close để trở về vùng soạn thảo nội dung của trang. 

Chương 

5 
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In tài liệu 

XXeemm  ttrrưướớcc  kkhhii  iinn 

Trước khi in tài liệu, ta có thể xem trước trang tài liệu sẽ được bài trí ra sao trên giấy. 

Cách thực hiện: 

+ nhấn chọn thực đơn lệnh File -> Print hoặc nhấn phím Ctrl + F2. 
 

HHộộpp  tthhooạạii  PPrriinntt  --  CCáácc  tthhaamm  ssốố 

Chọn thực đơn File->Print hoặc bấm tổ hợp phím Ctrl + P làm xuất hiện hộp thoại Print 
 

 

Trong phần Printer 

* Mục Printer: nhấn mũi tên để có danh sách chọn lựa máy in trong số máy in được cài đặt. 

* Ô chọn Print to file: nhấn chọn ô này để tạo ra tệp đặc biệt chứa khuôn dạng in. 

Trong phần Settings 

Danh sách một lựa chọn gồm: 

* ô Print All Pages: chọn ô này để xác định là in tất cả các trang văn bản. Nếu chọn tiếp 

ở danh sách chọn Print chúng ta có thể chỉ in:  
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- Các trang số lẻ (Odd pages) hoặc chỉ in các trang số chẵn (Even Pages),  

- Current Page để xác định trang in là trang hiện đang chứa con trỏ văn bản,  

- Selection để xác định là chỉ in nội dung văn bản được chọn (hay gọi nôm na là bôi 

đen). Trong hình minh họa, ô này không họat đọng vì không có vùng văn bản nào 

được chọn. 

* ô Pages : chọn ô này để xác định in theo số trang tùy chọn. 

Ví dụ: 

- gõ vào ô con số 1-50 để xác định in từ trang 1 đến trang 50, 

- gõ vào ô con số 1,2, 20-25 để xác định in trang 1, trang 2 và trang từ 20 đến 25. 

Trong phần Copies 

* Mục Copies: cho phép lựa chọn (hoặc nhập vào) số lần in của mỗi trang. 

Nhấn nút OK để bắt đầu in, nhấn nút Cancel để hủy bỏ các lựa chọn và đóng hộp thoại. 
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Thay đổi một số tuỳ chọn hệ thống 

Cách thực hiện 

+ Vào thực đơn lệnh File --> Options 
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- Thẻ Advanced cho phép đổi đơn vị thước đo sang centimet. Điều đó tạo thuận 

tiện cho người dùng khi đặt tùy chọn trong hộp thoại Page Setup. 

 

- Thẻ Save cho phép đặt chế độ tự lưu sau bao nhiêu phút. 
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- Tương tự vào thẻ Proofing để xoá các mục hiện có để tránh việc gõ văn bản 

Tiếng Việt luôn bị báo lỗi từ ngữ và văn phạm. Thực hiện hủy chọn ô Check 

spelling as you type và Check grammar with spelling. 

 
 

CChhứứcc  nnăănngg  AAuuttoo  CCoorrrreecctt 

Khi gõ văn bản tiếng Việt do chức năng Auto Correct mà chữ "i thường" sẽ tự động biến 

thành chữ "I hoa" khi sử dụng. Để tránh lỗi cần thực hiện như sau: 

+ Nhấn chọn thực đơn lệnh File -> Options -> Proofing. Nhấn nút AutoCorrect 

Options… 
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